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Foreword

This manual provides an introduction to the basic operations and functions of
the Work Instructions Composer.

While developing these functions we have made every effort to create a
clearly organized, easy-to-understand program structure.

A user-friendly interface as well as a clear menu guide will enable you to
quickly learn how to operate the program and to get familiar with its functions
so that you can carry out your planning tasks in a quick and reliable way.

Nevertheless, there will certainly be some things that we could do even better.
If you have any suggestions for improving our software, please be sure to let
us know.

We look forward to receiving your constructive feedback. It helps us to make it
even easier for you to work with the Process Engineer functions.

The same holds true for the manual that you are now reading. If, at any point
when using these instructions, you feel you are not being provided with the
clear, unambiguous, and proper guidance necessary to work with this applica-
tion, please be sure to let us know. We look forward to receiving your com-
ments and tips.

Please feel free to call, send us an E-mail, or contact our user hotline.

Please Send your Suggestions to:
DELMIA GmbH

Raiffeisenplatz 4

D-70736 Fellbach

Phone: +49/711/27 300-0
Fax: +49/711/27 300-599

E-mail: delmia.de.info@3ds.com

User Hotline:
If you have problems when using DELMIA products, please contact our user
hotline at:

Phone: +49/711/27 300-400
Fax: +49/711/27 300-599
E-mail: delmia.de.support@3ds.com

No Liability or Guarantee

Our programs and manuals have been compiled with great care and to the
best of our knowledge. They have also been tested in a production setting.
However, we assume no liability and provide no guarantee that the software
and related descriptions are free of error or are suitable for special purposes.

DELMIA assumes no liability for any damage that may arise from the use of
this software. By using this software, the user acknowledges this exclusion
from liability and shall hold DELMIA exempt from all claims.

Work Instructions Composer Version PE 5.19
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Copyright

The information in our documents may be copied and distributed for internal
purposes provided it is done free of charge and the contents are not altered or
distorted.

Any other form of usage, especially the sale on CD-ROM or in any other publi-
cation in whole or in part is only permitted after prior written consent by
DELMIA.

Some parts of this software are owned by Unigraphics Solutions Inc. and are
copyrighted © 2010. All rights reserved.

Some parts of this software are owned by combit® GmbH and are
copyrighted. Report-/Print module List and Label® Version 8.0: Copyright
combit® GmbH 1991-2010.

Modifications
Moreover, DELMIA retains the right to make modifications and improvements
to the product described in this manual at any time without prior notification.

DELMIA and the 3DS logo are registered trademarks of Dassault Systémes or
its subsidiaries, in the United States or other countries.

© 2001-2010 Dassault Systéemes - All rights reserved

Thank you for your interest in our products

DELMIA GmbH
Raiffeisenplatz 4

D-70736 Fellbach, Germany
Phone: +49 (-400)711/27 300-0
Fax: 49/711/27 300-599

Work Instructions Composer Version PE 5.19



Table of Contents

1. Introduction

11
1.2

How to Use this Manual
Documentation Conventions and Symbols

2. Work Instructions Composer Overview

2.1
2.2
2.3

About Work Instructions Composer
Prerequisites
Launching Work Instructions Composer

3. Loading Data
4. Work Instructions Composer Interface

4.1

4.2

Menu

4.1.1 File

4.1.2 Tools

Left-hand Panel

4.2.1 Processes

4.2.2 Products and Resources

4.2.3 Attachments

4.2.4 Work Instructions

4.2.5 Right-hand 3DVIA View Window

5. Authoring Work Instructions

5.1
5.2

5.3
5.4

5.5

5.6

Defining Planning Context

Loading Planning Context

5.2.1 Right-mouse Button

5.2.2 Single click selection

5.2.3 Double click selection

Selecting from the Product / Resource Lists
Using the Work Instructions Text Editor
5.4.1 Work Instructions Library

Concurrent Planning Enabler

5.5.1 Unlock Objects

5.5.2 Updating a Process Plan

Using the Embedded ActiveX 3DVIA Player
5.6.1 Double-click on a Product

© © © O N o o 0 O w w W

Nl e e =
R B B O O O

N B Rr R R R R R R R Rk R PP
O © © O oo OO O o O w w N DN

20

Work Instructions Composer

Version PE 5.19



z

5.6.2 3DVIAView Thumbnails 21

5.6.3 Double-click on a 3DVIA View Thumbnail 21

5.6.4 Product Build-up View in 3DVIAView 21

5.7 Viewing Engineering Requirements and Black Box Components-22
5.7.1 Engineering Requirements 22

5.7.2 Black Box 22

6. Saving Work Instructions 24
6.1 Filters 24
6.2 Data Saved 24
6.2.1 Work Instruction Texts 24

6.2.2 Planning Context 25

7. Limitations 26
7.1 Limitation #1 26
7.2 Limitation #2 26
7.3 Limitation #3 26
7.4 Limitation #4 26
7.5 Limitation #5 26
7.6 Limitation #6 26
7.7 Limitation #7 27
7.8 Limitation #8 27
7.9 Limitation #9 27
7.10Limitation #10 27
7.11Limitation #11 27
7.12 Limitation #12 27
7.13Limitation #13 27
7.14 Limitation #14 28

8. Best Practices/Methodologies 29
9. Glossary of Terms and Abbreviations 30
List of Figures 31
Index 32

Work Instructions Composer Version PE 5.19



Introduction

1. Introduction

This manual explains how to use the Process Engineer Work Instructions
Composer for your planning purposes.

1.1 How to Use this Manual

a

This manual enables you to get familiar with the operation and functions of the
Work Instructions Composer.

This manual briefly describes:

= How to load data from the Manufacturing Hub (MH) database in order to
author work instructions.

= How to author work instructions using the Work Instructions (WI) Com-
poser.

=  How to save work instructions back to the MH database.

Note

When handling the basic settings functions, please remember that there is a
general introduction to the Process Engineer in the Basic Manual.

Click General Introduction to access the manual.

1.2 Documentation Conventions and Symbols

Pt
' 3

Al

o

The symbols used in this manual are intended to provide you with keys to the
contents in an immediately understandable manner.

This symbol is used to introduce key concepts that are covered in the sections
immediately following this symbol. As a result, this symbol most frequently ap-
pears at the beginning of chapters or sections.

Note

This symbol is used to mark notes, which provide you with additional informa-
tion you need to have for further work. You will either find the Note sign at the
beginning of a chapter or in a particular text passage in the chapter. Texts
bearing this sign are additionally marked with Note. The text is always in ital-
ics.

Caution

This symbol indicates that the text that follows describes particular circum-

stances that you must avoid to avoid potential errors with the operation of the
program or harm to data. You will either find the Caution sign at the beginning
of a chapter or near a particular text passage in the chapter. Texts that are in-
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troduced by this sign are additionally marked with Caution. The text is always
in italics.

m This symbol marks examples which serve to illustrate a certain situation.

1)  This symbol marks the individual operational steps involved in a particular op-
erating instruction. Operating instructions describe operational steps, for ex-
ample, how to open a menu or execute a function.

« This symbol marks listed subjects. The symbol for listed subjects can be either
used to structure a continuous text or to list main subject keywords.

»  This symbol marks list inside a bulleted or numbered list.

m This symbol marks cross reference information that is available in another
manual.

Work Instructions Composer Version PE 5.19
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Work Instructions Composer Overview

2.1 About Work Instructions Composer

This gives you the capability to load process planning and work instructions
data from the Manufacturing Hub (MHub) to the Work Instructions Composer
(W1 Composer).

You will be able to author work instructions, create annotations, mark-up, etc.,
to the process.

2.2 Prerequisites

You need to have knowledge of the Process Engineer application and need to
know about processes, products, and resources as those terms apply to
Process Engineer applications. You also need to have a basic knowledge of
objects in 3DVIA Composer and 3DVIA Player applications such as creating
views, mark-ups, Digger, etc.

= Licenses for the Work Instructions Composer and the 3DVIA Composer
products are required. The 3DVIA Composer version that is compatible
with R19 is V6R2009x. Therefore, you need to use this version of 3DVIA
composer while working with R19 version of Work Instructions Composer.
The compatible 3DVIA version from R19SP3 onwards is V6R2009x HF7

=  Core XML services — MSXML 6.0 is required and can be downloaded from
the Microsoft website.

= Unzip 5.52 is required. This is free software that can downloaded and in-
stalled from www.info-zip.org. The software must be added in the PATH of
the system.

2.3 Launching Work Instructions Composer

=) 4 MH-2DVIA Y BOMEny | @1
= 'ﬂ Process View, 1 :[_
= €4 Process Plan, 1 T | Lol s ]
=@ o
@ opt, 1] New ' f?'
% 0p2, 1 attributes at Same Time :"?I
" 0p3, 1 Change Planningstate ’
d% op4, 1 Change Protocol
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Design Yiew, 1 Edit (Create) Time Analysis
= fm Subassemb  Find
& Py, Highlight Usage
& partz, Yersions
ﬁ Part3, Calculation
% () Default-vSR18 el
# 3 Project Library exra
MNew Resource Yiew,
= 4 new Site, 1
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=) s New Factor Permissions » IGRIP
of Machin g ¥ Process Engineer
of Machin  siprs »oowne
WI Composer

Figure 1: Launching Work Instructions Composer

Find Usage

Line Number

Work Instruction Composer can only be launched from the Process Engineer.
To launch WI Composer, here is the procedure:

Select a Process Node, in this example — Workplan, 1 - from the DPE client.
Using the right mouse button, select Open in > WI Composer.

Work Instructions Composer Version PE 5.19


http://www.info-zip.org/

Work Instructions Composer Overview 6

The WI Composer is started.
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the housing 0op3, 1

Op4, 1

Ready - ,_’_,_/‘l
Figure 2: Work Instruction Composer Window

To be able to launch WI Composer, you need to set the path location where
the WI Composer executable is installed so that using the right mouse button,
DPE can pick the excutable from this location. To set the path location of the
executable Click Tools > Settings > Change > Other DS Software Modules
and set the path for WI composer executable (DWIC.exe)

Work Instructions Composer Version PE 5.19
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3.

Loading Data

The terms processes and operations are used interchangeably throughout this
document. You must have read permissions for the data in order for it to suc-
cessfully load.

Processes:
When you select a process node to send this data to WI Composer, the first
level children of the selected process is loaded into W1 Composer.

If the loaded process has no children, WI Composer will not launch and you
will be instructed to launch the application from the parent level.

If the processes are sequenced (process_runs_before_process relation in
Process Engineer), they will appear in that sequence in WI Composer. If there
is no sequence defined, then the processes will be randomly listed.

Once the process and its children are loaded, they are locked by the current
user and cannot be edited by another user.

You must have Read permissions for the data in order for it to successfully
load the process data.

Products:

Products assigned to each of the first level children are sent to WI Composer.
This list of products will appear as a list in the WI Composer view window. In
the tree view of the 3DVIA, there is a node dedicated for the products under
the ROOT node.

Two variations can exist;

= An assembly is assigned to a process. The entire assembly, with all its
children, are loaded into the WI Composer. You can see this in the tree
view of the 3DVIA application.

= A single product within an assembly structure is assigned to a proc-
ess. In this case only the assigned product will be visible in the tree view of
the 3DVIA application.

You must have read permissions for the data in order for it to successfully load
the product data.

Resources:

Resources assigned to each of the first level children are sent to WI Compos-
er. These resources will appear as a list in the left-hand panel. In the tree view
of the 3DVIA, there will be a node dedicated for resources under the ROOT
node.

You must have read permissions for the data in order for it to successfully
load.

Manufacturing Assembly (MA):
If a Manufacturing Assembly is associated to a Process, then the Manufactur-
ing Assembly is also sent to the WI Composer.

If a MA has children, all the child parts will be loaded in WI Composer.

MA respects the same relation as products so that any MA that is assigned
with one of the relations previously mentioned will be considered.

You must have Read permissions for the data in order for it to successfully
load.

Work Instructions Composer Version PE 5.19
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Manufacturing Kit (MK):

If a Manufacturing Kit is associated to a Process, then the Manufacturing Kit is
also sent to the W1 Composer.

If a Kit has children, all the child parts will be loaded in WI Composer.

MK respects the same relation as products so that any MK that is assigned
with one of the relations previously mentioned will be considered.

You must have Read permissions for the data in order for it to successfully
load.

Planning Context:

Planning context is a collection of all the different parts that are needed when
installing or planning a given Workplan/Installation. For the planning context to
be loaded into WI Composer you need to have a previously defined planning
context for a given process. The planning context can be defined using a DPM
V5 product or using Define Planning Context command in W1 Composer

Assumptions about the Geometry Files loaded in WI Composer:

The WI Composer application will not generate the needed smgGeom and
smgXml files on the fly from the assigned products, resources, or CGR files.
The smgGeom and smgXml files need to be pre-generated and this can be
done by setting up the 3DVIA Sync to generate these files from a given file lo-
cation and create these files in another or the same location.

The locations in which these files are created needs to be specified in the
attribute_25 attribute of the product / resource object in Process Engineer. You
need to set the “smgXml” file of the product/resource for the attribute 25.
Please note that you cannot assign smgGeom nor the plain smg file. It needs
to be smgXml file. If this attribute is already used, then you can specify an al-
ternate name of the attribute through an environment variable
MH_3DVIA_SMGGRAPHIC.

Example. If you want to use graphicname_alt6 as the attribute where all the
SMGGEOM and smgXml files are located, then you should specifically set
MH_3DVIA_SMGGRAPHIC = "graphicname_alt6", so that software knows

where to find the geometry files.

NOTE: The Environment variable is common for both products and resources.
Also if the Environment variable is set, then the software will only look for the
smgXml file specified through this Environment variable and then ignores the
attribute 25. So, you should either use the Environment variable or use the
attribute 25.

For the files coming from ENOVIA Vault, the CATPart/CATProduct files need
to be extracted from the Vault and then copied onto a file system so that
3DVIA Sync can then be used to generate the needed smgGeom and smgXml
files for these data.

It is out of the scope of this document to describe how to extract the prod-
uct/part files from ENOVIA Vault and how to generate the smgGeom and
smgXml files for these data coming from Enovia Vault.

If there is no smgGeom and smgXml files for a given CATProduct, then you
will not see the geometry for this in the 3DVIA view. The error will be logged in-
to a text file which you can later refer to after loading. The log files, by default,
are located in the windows temp directory. Example: C:\Documents and Set-
tings \ your login \ Local Settings \ Temp.

Work Instructions Composer Version PE 5.19
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4, Work Instructions Composer Interface
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Figure 3: Work Instruction Composer Interface

As illustrated in the image, there is the left-hand panel and the right-hand
embedded 3DVIA Player window where views are displayed. The thumbnails
are views that map to operations and are displayed on the left of the player

window.
4.1 Menu

4.1.1 File
Save As — You can save as an *.sm( file to a file system.
Save - This will save all the changes that you have made in WI Composer
back to the Manufacturing Hub (MH) database. After saving you can continue
working.
Exit - This closes the application.

4.1.2 Tools

Load Planning Context — You can load a planning context if it already exists
for given process.

Define Planning Context — You can define the six float values needed to de-
fine the bounding box for performing a volumetric query search.

Concurrent Planning Enabler — Two options are available from here:
= Unlock Objects

= Update Process Plan

Work Instructions Composer Version PE 5.19
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4.2 Left-hand Panel

4.2.1 Processes

This is a list of processes that are first level children of the loaded process. All
the first level children of the loaded process will be queried from MH and will
be shown in the list.

You can use the right-mouse click on a given process which will display two
choices:

View Properties of the Process — This allows you to see the name and de-
scription of the process.

Enrich a Given Process — This allows you to enrich a given product through
3DVIA composer product. The details of Enrich are documented here.

4.2.2 Products and Resources

This is a list of products and resources that are assigned to the currently se-
lected process. This list gets updated based on what process has been se-
lected in the Process List. If a MA/MK is assigned to the process, then the
name of the MA/MK will be shown in the list.

Here are some notable points:

= The list is presented in the form of tab pages; one tab page for product
and one for resource. In each of the tab page, there are two pieces of in-
formation given:

» The name of the assigned object: This name is consistent with the name
shown in the E5 PPR tree for this object.

» The name of the relation with which this object has been related to the se-
lected process. The list of relations that are supported for product and re-
sources while loading are documented here.

= The name of the actual assigned object will be shown.

» E.g. There is a "Assembly-A" that has 2 parts - Part1, Part2. The "Assem-
bly-A" has a relation to the process. In the list, only the name of assembly
(which in this case is "Assembly-A" will be shown). The children are NOT
shown. The children are nonetheless visible in 3DVIA view as well as in
the 3DVIA assembly tree.

> In the above example, if only Part2 is assigned to a process, then the list
will only show the assigned "Part2" and will not show its parent Assembly-
A.

Cross-highlighting is supported between the product list and 3D View. When
the product is selected in the list the part is highlighted in 3D and vice-versa. If
you select an assembly, then all the products within the assembly will be hig-
hlighted.

Work Instructions Composer Version PE 5.19
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4.2.3 Attachments

Once you have associated an attachment to a Process/Operation, then the at-
tachment can be seen in WI Composer. The attachment will be listed in a sep-
arate tab page called "Attachments".

Fil= Mame or LURL
hkkps e, 3ds, com

[:\Processspec, pdf

Figure 4 Attachments Tab

All available attachments for the selected operation/process will be listed. You
can double-click on an attachment and it will open based on what type of the

file it is, i.e., *.ppt files will launch in MS Powerpoint, an html file will open in a
browser, etc.

This tab page is updated based on what process has been selected in the
process list or the view in 3DVIA.

If using Internet Explorer (IE) 6 and multiple hyperlink attachments are se-
lected, only the last one selected will open.

4.2.4 Work Instructions

This is a text editor that allows you to type work instructions or copy / paste
them from another application such as MS Word, Notepad, etc. Details are
explained in Chapter 5.

4.2.5 Right-hand 3DVIA View Window

4251

4252

3DVIA View Mapped to Operations

The process in the MH is mapped to a View in the 3DVIA player and is a
snapshot of the screen properties. You can save and restore them at any time.
There is a 1:1 mapping between each of the child processes of the loaded
process and each of the 3DVIA Views. The name of the view is the same as
operation name that appears in the process list in the left-hand panel. The
views will appear in the same order as sequenced in the MH database (Using
process_runs_before relationship.).

The 3DVIA View is created fresh when you have loaded for the first time. In all
subsequent loads, the previous modifications and edits that you make will be
loaded and retained. The name of the view will be the same as the name of
the operation. There is a limitation that no two views can have the same
name, so please ensure that no two operations in MH have the same name.
(Operation in MH maps to a view in 3DVIA.)

Embedded 3DVIA Player

The WI Composer application embeds the 3DVIA Player using ActiveX con-
trols.

The same set of commands which are available through the default 3DVIA
Player is also available in the embedded ActiveX 3DVIA Player. To enrich the
work instructions, you can annotate the part / resources using the set of tools
exposed by the 3DVIA Player in a given view.

Work Instructions Composer Version PE 5.19
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Authoring Work Instructions

If there is a planning context defined for a given process, you can use Tools >
Load Planning Context to load that context. Or, you can define a planning
context using Tools > Define Planning Context.

5.1 Defining Planning Context

When you choose Define Planning Context, the Define Bounding Box dialog
is shown so that you can define a bounding box. You can also see a bounding
box in the 3DVIA window. You can manipulate the bounding box in the 3DVIA
window to define the size of the bounding box visually, as shown in the follow-
ing illustration.

ﬂ DELMIA Work Instruction Composer - INSTALL RIBS FOR LEFT WING, 1

File  Tools Help
CIEd
INSTALL RIBS FOR LEFT WING, 1 h H e 0 @t' 6 K’) K.ﬁ 6

M pssemble Spars and Junction Plat...

A Assamble Rib 7 and Rear Spars, 1 J

M psse 5= - 0 . ‘
Define Bounding Box
A Assg s
M Assi
M Fingl  in: | 9773,413000 i | 11188,530000
Vin: |-4TE|D‘944DDD Ymax: |-3253.4sannn
<
——— | Zmin: |-1312 446000 Zma; | -738.168000
Produc
Produc Get Bounding Box |
‘Lan
ﬁRl’ Candition: IFUHV n -
Ok | Cancel

OBBox 1

B o] @] %|es|E

Wark Instructions |

Ready . ,_,_,_ /a
Figure 5 Bounding Box

Once a Bounding Box is defined in 3D, as shown in the illustration above,
remember to click the Get Bounding Box button.
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Define Bounding Box

%min: | SRLRAI| wnax | 10,000

s |3

¥min: | -10.000 ¥max: | 10.000

Zmin; | -10.000 Zmax; | 10.000

Get Bounding Box |

Condition: |Fu||‘:.f In j

Figure 6 Define Bounding Box

You can enter the six float values; Xmin, Xmax, Ymin, Ymax, Zmin, and Zmax,
that define the bounding box and also the criteria for the search — Fully In or
Partly In.

= Fully In: With this option, the query will search the database for all the
parts that are fully inside the defined bounding box area.

= Partly In: With this option, the query will search the database for all the
parts that could be partly inside the defined bounding box area.

OK: This will launch the E5 query for parts in the bounding box and loads this
planning context into the session.

Cancel: This will cancel the command.

Once you save the session, the planning context will be saved back into the
MH as a blob on the loaded process.

NOTE: In order to load any parts through a Bounding Box query, the parts de-
fined in the MH database should have those bounding box limits, otherwise,
the software has no values to check against to load.

5.2 Loading Planning Context

You have the ability to load a planning context if it already exists for given
process. The previously defined planning context will be loaded under a dedi-
cated node calling Planning Context under the ROOT node in the assembly
tree and you can see these planning context parts in all the views.

Note that, if a part/product already exists in the Product List, then it will not be
loaded again as part of the planning context.

5.2.1 Right-mouse Button

You can use the right-mouse button and click on a given process in the
process list. Two more options will be available.

Work Instructions Composer Version PE 5.19
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5211

5212

14
Properties

You can query the properties for the selected process. Currently, the software
only supports the Notes attribute defined on the process.

Enrich

Standalone 3DVIA. You can select a given process and launch a standalone
3DVIA Composer session only for that operation. When a standalone 3DVIA
composer is launched, the W1 Composer window will be unavailable and will
be reactivated only after you have closed the standalone 3DVIA Composer
session. There is no multi-selection supported for this option. Once in 3DVIA

composer session, you can enrich the view by adding more annotations, mar-
kups, etc.
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Figure 7 How to Launch Enrich
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Figure 8 View Launched in 3DVIA Composer Session after Enrich

After adding the annotation / markups, etc., you need to complete Update
View to see the changes and save the file. Once you exit the 3DVIA
Composer, you can see that the changes you made are automatically
synchronized in the WI Composer.

NOTE: It is mandatory to use File > Save in order to see the changes back in
the WI Composer.

Currently, Creating Animations is not supported and is not synchronized back
into W1 Composer from a 3DVIA Composer session.

Creating Multiviews in 3DVIA. You can create multiple views for a given op-
eration and save those in the Manufacturing Hub.

While in Enrich mode add new views. When the 3DVIA composer session is
saved and returned to WI Composer, the new views will be associated to the
Operation on which Enrich was launched.

e If you make changes to a given view then the change is visible only for
that view. Example: Op1 has three views: V1, V2, V3. Add an annota-
tion to V2 to change it. That change will only apply to V2.

¢ If you create multiple views associated to an operation in a previous
session, then in the next session, you can choose to remove the view
in 3DVIA Composer and the changes will be synchronized. However, if
you delete ALL views, then the software will still retain at least one
view for the operation.

If you add any new part or resource to the operation, then, when you load the
operation each view corresponding to the operation will show the newly added
part or resource. Or, if you removed or unassigned a part from the operation,
this this will be removed from all views corresponding to the operation.

Any change you make to an individual view will be maintained when the views
are loaded from the MHub.

Multiple Views behavior in WI Composer.

¢ When you double-click on an operation in the left-hand panel, if there
are multiple views associated with the operation, the “first” view will be-
come the active view by default. To make a different view active,
double click on the thumbnail associated with the view.

¢ If you are using step through commands with the VCR controls, the
software will also step through all the available views. This is because
the views are always in sequence in WI Composer and the Next button
will go to the next view for the current operation.

e Each view that is associated with an operation will follow the life cycle
of the operation. If the operation is deleted, it will also delete all views
associated with the operation.

Multi Views Limitation. While running step through commands in W1 Com-
poser, the system will walk through each individal view corresponding to the
operation. This is because in 3DVIA, the views are always in a sequence and
are not structured. So if Operation1 has three views and Operation2 has two
views, then all five views are in sequence and the Step Through function has
to pass through each of the views.

5.2.2 Single click selection

If you select a process with a single click, then the following will happen:
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= The Products and Resource list will be updated to show the assigned ob-
jects for this selected process.

= In 3DVIA, the view corresponding to this operation will be selected, that is,
the thumbnail in the left side will be selected.

=  The Work Instruction, if any, for this process will be shown in the Text edi-
tor pane.

If you make a multi-selection, then the single-click behavior will apply for the
first selected process, as it is impossible to synchronize product/resource lists
for multiple operations!

5.2.3 Double click selection

If you double click on a process, all the actions mentioned above for a single
click will happen. In addition, the 3D view will be updated and the view corres-
ponding to this selected process will become the active view. If you make a
multi-selection, then the double-click behavior will apply for the first selected
process as it is impossible to synchronize product/resource list for multiple op-
erations.

5.3 Selecting from the Product / Resource Lists

From the Product or Resource list you can:

= Use a single click on a product or resource, which will show the item se-
lected in the 3DVIA Player window. The product or resource will be out-
lined in the chosen color and in the assembly tree of 3DVIA. You can per-
form multi-select of products or resources.

= Use a double-click on a product or resource. This will zoom the view in the
3DVIA Player window and be reframed to the selected product or re-
source. It will be highlighted in the assembly tree of 3DVIA. You can per-
form multi-select of products or resources.

5.4 Using the Work Instructions Text Editor

The text editor allows you to apply Rich Text Format (RTF) to Work Instruc-
tions. Font, font size, bold, italic, underscore, and text color are available via
buttons in the text editor. Additionally, the formatting will be imbedded when
the data is saved to the Manufacturing Hub and restored when the data is
loaded again. The RTF enriched text can be extracted from the MES partners
and can be displayed in their viewers.

You can copy / paste from other applications such as MS Word or Notepad. If
the text is RTF, it will be preserved in the copy/paste from another application.

5.4.1 Work Instructions Library

A Work Instruction Library contains sets of instructions which provide more
details of how a specific Process needs to be carried out. The library can
contain one or more such instruction items. The library is defined and stored
as an object in the MH database as part of a Plan Type Set. In a real time
scenario, the WI Library is expected to be defined/authored by an
administrator.
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You can create a set of libraries for different work situations in the shop floor.
For instance, a DRILL LIBRARY, PAINT LIBRARY, etc. Once the libraries are
defined, you can define Library Items (LI) that will contain text with details of
the work instructions.

The picture below shows a sample LI defined in DPE:

B Work Instruction Library ltem =Machine Drill=

Froperties l
General
Name — IMachine Diil
|dentifier |
Hyperlink 1
Text Drrill holes of diameter [Diameter] wsing a machine drill.
Followe the zpecification number SPEC 9037 az mentioned in the FAd regulations
Obzolete -

Azzigned Y5 Scpt
Script Mame |

Parameter List

Figure 9 Work Instruction Library Item Properties

5.4.1.1 Ability to choose a Library Item in WI Composer:

Once you have associated a W1 Library to a WIText plan type, you can choose
this library and the LI inside of this library to automatically copy the text from
this template and make a Work Instruction from it.

Use the right-mouse to select text editor. Using the right mouse button, you
can select a work instruction library and library item.
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I
B z[u[m[®] [ [t

ok, Instructions ]

Select work Instruction Libraries. .

Rrar

Figure 10 Work Instruction Library List
Once you have select a library item, you will see a preview of the text.

Shown below is an example.

Work Instruction Library

=2y Whork Instruction Libraries
—a FASTEMIMNG LIERARY
~ 4 Join Using Rivets
@ Join Using Adhesives
=% DRILL LIBRARY
®

@ Machine Orill

W Text:

Crrill Filak hales of diameter [Diametet] ak an anagle of [Anagle] as per
the specification number SPEC- 023F45

o 4 Cano

Figure 11 Work Instruction Library Item Preview

When you click OK, the text shown in the preview will become the WI text in
the WI Composer. You can edit this text field and enter values for the text
fields; here shown as <Diameter> and <Angle>.

B z[ufm®] ]

wark Instructions l

Drill holes of diameter <Diameter:- atan
angle of <Angle>=|
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5.5 Concurrent Planning Enabler

You can make changes in the Process Engineer even when a Work Instruc-
tions Composer session is open. There are two commands available:

= Unlock Objects

= Update Process Plan

5.5.1 Unlock Objects

The following objects will be unlocked in Manufacturing Hub using this com-
mand:

= The Loaded Process plan (like Workplan) and all the children of the Work-
plan will be unlocked so that you can add/delete/edit Operations and
WiText.

= Products and Resources will be unlocked so that your can change the as-
signments and/or make any other editing that Process Engineer permits.

Once you click on this command, you will be prompted to save any of the
changes you have made in the WI Composer. Once you make a selection, the
File > Save is not available. This is to ensure that you don’t make any changes
in WI Composer after the locks on objects have been released.

You cannot make or save changes until you click Update Process Plan and
exit Unlock.

5.5.2 Updating a Process Plan

5.5.2.1

5.5.2.2

Selecting the Update Process Plan command will enable you to see, in WI
Composer, the changes that have been made on the Process Engineer side.
The WI Composer will be synchronized with the changes made in DPE.

After the software makes all the changes to update the process plan, the File
> Save is available so that you can continue working in WI Composer.

The following cases are supported through the Update Process Plan com-
mand.

Adding an Operation

If a new operation is added to an existing set of operations underneath of a
parent, then during update process, a new View will be inserted in Wl Com-
poser corresponding to the new added operation. The update mechanism will
respect the sequence of the addition. That is, if an operation Op3 has been
newly added between Op2 and Op4 and is sequenced, then it will be shown in
the same sequence even in WI Composer. But if the operation has been in-
serted arbitrarily under a Workplan, then the order in which the View corres-
ponding it will appear in the WI Composer is not guaranteed, because there is
no logic underlying for the software to display. The tree display is not a good
indicator for the order of objects.

Deleting an Operation

If an existing Operation is deleted from an existing set of operations beneath a
parent, then during Update Process Plan, the view corresponding to the de-
leted operation will be removed from the W1 Composer session. The update
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5.5.2.3

5.5.24

5.5.2.5

5.5.2.6

mechanism will respect the sequence after deletion, meaning, if an operation
Op3 has been newly deleted between Op2 and Op4 and re-sequenced in
DPE, then it will be shown respecting that order even in Wl Composer.

Changing the Attribute of the Operation

Changing Name and Notes attributes of Operations will be reflected in W]
Composer.

The operation and view name are the same. Therefore, when the name is
changed in DPE, the view is renamed in WI Composer to match the new op-
eration name. In addtion, the NOTES information and balloon help is
changed.

Re-sequencing the Operations

When a sequence of operations is changed in DPE, the corresponding W1
Composer sequence for each operation will reflect the re-sequencing. The
product build-up computation will change accordingly.

If the sequence has been completely changed, the software performance will
affected because of the massive recomputation that has to be completed to
ensure proper product build-up and correct resource display.

Assigning / Unassigning New Parts / Resources to the Opera-
tion

If you change the assignment of parts/resources to operations, the update
mechanism in WI Composer will reflect this change. Each of the views for the
operations will be updated to manage the visibility of products/resources as
established with the assignments.

The product build-up is also recomputed to reflect the assignment / un-
assignment of products and resources. The principal rules on which product
build still remains unchanged; meaning, it is still based depending on the types
of relations used to assign the parts and resources to the operations

Changing the attribute of the Product / Resource

If you change the name of the products / resources that are assigned to the
operations, then the correct names will be displayed in the Product and Re-
source lists that are shown for each Operation. The same changes are also
made in the assembly tree in the 3DVIA window.

5.6 Using the Embedded ActiveX 3DVIA Player

This product allows all the native user interface capabilities provided by the
ActiveX 3DVIA player such as, selecting an object from the assembly tree,
double-clicking, etc.

Some methods of selecting objects in the left-hand panel of WI Composer are
described below:

5.6.1 Double-click on a Product

When you double-click on a product in 3DVIAView or in the Assembly Tree,
the camera will zoom on the product selected, which is general 3DVIA beha-
vior, and the product will also be highlighted in the list view of products and re-
sources (WI Composer behavior).
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5.6.2 3DVIAView Thumbnails

The views in 3DVIA that map to the processes will be sequenced in the same
way that they are sequenced in the MH with a “Process runs before Process”.
Also, the ActiveX 3DVIA player does not support capabilities such as Adding a
View, Deleting a View, or re-sequencing the views; therefore all these opera-
tions need to be done only through the left side panel of the application.

5.6.3 Double-click on a 3DVIA View Thumbnail

When you double-click on a view thumbnail, the process corresponding to that
view will be selected and highlighted in the list. The Product/ Resource List will
also get synchronized to show the products and resources for that selected
process.

If you have made edits in the views, then you need to update the view in the
embedded 3DVIA player.

5.6.4 Product Build-up View in 3DVIAView

5.6.4.1

5.6.4.2

You will have the ability to see a build-up of the products in WI Composer.
Product Build-up

When the higher level process such as a Workplan that aggregates processes
is loaded into WI Composer, the processes are loaded along with their as-
signed products and resources. There is one 3DVIA View generated for each
of the processes. You can navigate through the different views using the Play
View buttons in the player.

Behavior of product build-up with different relations

Process Runs before Process

The product build-up is computed based on the "Process Runs before
Process" relation between processes (aka Control Flow in DPM V5 terminolo-
gy). So the product build-up will be shown as long as there is a control flow
link between the processes. If there is no link /or the link is broken, then the
product build-up will not be shown for this unlinked process.

If you initially had no links, then when this process is loaded in Work Instruc-
tions Composer, there will be no product build-up. However, returning later to
Process Engineer and connecting the process, the next time data is loaded in
Work Instruction Composer, the views will show a product build-up. In other
words, at load time, the software will compute the build-up properly in accor-
dance with the control flow links in the Manufacturing Hub database.

Process Processes Product
Process First Processes Product

Process Creates Product
The Views will show a cumulative build-up of the products if the parts/products
are associated to a process with any of the three above-mentioned relations.

Process Removes Product

If a product is associated with a Process Removes Product relation for a given
process, then that part/product will be removed from the build-up for that
process.

Process Attaches Resource
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5.6.4.3

Process Detaches Resource

There is no concept of Resource Build-up. But the Process attaches resource
relation has a special consideration. If a Resource has been assigned to a
process with a Process attachés resource relation, then that resource will con-
tinue to be shown in the all the views in the sequence until there is a relation
of type "Process detaches Resource' to that same resource. When there is a
process detaches resource, then from that point onwards this resource will not
be shown in the subsequent views.

Process Implements Requirements

There is no build-up shown for the parts associated with the Process Imple-
ments Requirements (PIR) relation. Only the entities that are associated with
the current process will be shown for the PIR relations.

NOTE: Only the products are included in the build-up. It does not include
dress-up, i.e., markups, annotations, etc., from one view to another.

Override of Product Build-up

You can manage the hide/show of the products manually in a given view (ex:
in the 3DVIA assembly tree user can check/uncheck the box to show/hide the
products). In that case, the software will respect the hide/show setting as
made by the user. You will have the ability to see a build-up of the products in
DELMIA Work Instructions.

5.7 Viewing Engineering Requirements and Black Box
Components-

The Engineering Requirements / Black box components that are associated
with an operation are displayed in the "Product List" as illustrated and
described in the following paragraphs and illustrations. Additional information
on Engineering Requirements can be found in V5 documentation: “DPM
Process and Resource Defintion — Engineering Requirements Planning®.

5.7.1 Engineering Requirements

The name of the part that contains the Engineering Requirement (ER) along
with the Functional Tolerance Annotation (FTA) and the geometric object that
was assigned to the operation in DPM V5. The name displayed here is
consistent with what is seen on the relation object in DPE client as well.

Products ] Resources |

Product Name | Relation
p PART | FlagNate.1 + Paint.1 Process Implements Requirements  (Partial)
p PART | Flaghote.1 + Paint2 Process Implements Requirements  (Partial)

Figure 12 Engineering Requirements

5.7.2 Black Box

The name of the black box part that is planned for the operation is shown.

The product list shows each of the individual parts inside the blackbox that are
associated with the selected process. When you select one item in the list,
that entry is highlighted in the 3D view.
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Products IResources ]

Product MName I Relation
ﬁ BlackBox Prod | Part-B Process Processes Product
ﬁ BlackBox Prod | Part-A Process Processes Product

Figure 13 Black Box listing

For example. If you select BlackBox / Part-A on the list, then Part-A is
highlighted and it is also highlighted in the assembly tree.

When you double click on an entry, the 3D view is zoomed to that specific part
inside the BlackBox.
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6. Saving Work Instructions

Use File > Save to Manufacturing Hub to save the data that has been
created in the WI Composer application back to the MH.

6.1 Filters

All WI Composer authoring, mark-up, etc., is recorded against a given filter
setting that was used for loading. The filter settings for the enitire WI
Composer session is the same as the filter setting that was used when the
DPE project was opened.

While loading data in W1 Composer, a check is made to determine whether the
filters of the process that is being loaded match the filter of the other project. If
the filters match, the Wl Composer is opened in Edit mode, otherwise, WI
Composer will be opened in a read-only mode.

6.2 Data Saved

The following data will be saved back to MH from the Wl Composer applica-
tion

= Work Instruction Texts
= 3DVIA Views containing the View-specific data
= 3DVIA XML file on the loaded Process node

= Planning context
6.2.1 Work Instruction Texts

The work instructions text can be authored in a simple text editor in the WI
Composer application. This data will be saved as a Work Instruction object
created directly under the operation. After saving the data back to the MH, you
can see the textual content of the string within the Display Text box as shown
in the illustration.

If a WI Text has been created by inserting from an existing WI Template Li-
brary, then when this WI Text is saved, the software will manage a link be-
tween the Library Item and the W1 Text. This can be useful when you want to
run an impact analysis tool to determine which W1 Text objects need updates if
a Library ltem were to be changed.

In this example, the work instruction “Drill holes of diameter 10 mm” under As-
semble Spars and Junction plate,1 was created. When saved, a new WiText
activity was created and the Display Text box is filled with the same textual
content.
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- 4= WorkinstructionsComposerProductDemo ar vuw' &l Effectivity a8l Work Instruction |
= 2 Process View, 1
= &3 Process Plan, 1 Displyy Text  Inyeiit holes of dinameter 100 mm

= 4™ INSTALL RIBS FOR LEFT WING, 1
- M Assemble Spars and Junction Plate, 1

ar Assignad Work Instruction Library ltem
4 ™ Ascemble Rib 7 and Rear Spars, 1
4 ™ Assemble Ribs 1,3 with Front Spars, 1 Name
+ ™ pscemble Ribs 4, 5, 6 to Spars, 1 f |dentifies
+ ,an Assemble Landing Gearbox Structure, | i Hyperink

Figure 14: Display Text Box

There can be only one WIText activity under a given operation. When this op-
eration is reloaded into the WI Composer session, the same display text is
shown and you have the choice to edit the text.

IMPORTANT: To save Work Instructions text in MH, the WiTextplantype
should be customized to be an authorized child of the operation for which
the Work Instruction is being authored.

6.2.2 Planning Context

If you have defined a planning context in the WI Composer application, during
the Save, this planning context will be saved as an XML blob on the loaded
process.
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7.

Limitations

7.1 Limitation #1

7.2

7.3

7.4

7.5

7.6

The “Process List” only shows the first level child processes. There is no ca-
pability to see a deeper level of children. There is no access for the different
properties of the process other than “Description” (or Notes) for a given
process. Also, there is no capability to ‘Add Operation’, ‘Remove Operation’,
‘re-sequence’ or to ‘assign products and resources’ within this application

Limitation #2

The system does not bring in Precedence Constraints information from MH.
and there is no support for parallel processes. If there are parallel processes
under a given parent, then the system will randomly serialize the processes
that are in parallel and when saved in the database this will change the se-
quence.

Limitation #3

The only attributes that you can see for the product in the list view is the name
of the product that is displayed. There is no access for other attributes of the
product or resource. You cannot assign resources or MA/MK to processes in
WI Composer.

Limitation #4

ER Limitation

When the assigned Engineering Requirement (ER) information is displayed in
the Product list, it is not possible to display the name of geometric set, if any,
in which the ER is residing.

Limitation #5

Build-up Limitation #1

The build-up is based on the "Process Runs before Process' relation. It is not
based on precedence constraint, so you must create runs before relation to
see the build-up behavior. If there is a broken link between the processes,
then the build-up will not be shown from that point onwards.

Limitation #6

Build-up Limitation #2

There is no build-up of the annotations, markups, etc., that are created in a
previous view. The software will do a build-up only for the products.
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7.7 Limitation #7

Build-up Limitation #3

In order to see what products are associated to a given process during a build-
up, you need to use the left view - the one that shows product list - and make
a multi-select it to see all the assigned products.

7.8 Limitation #8

No two operations in MH should have the same name because two views
cannot have the same name in 3DVIA.

7.9 Limitation #9

When the planning context is loaded, the parts that are in the list of planning
context are not filtered for a configuration. In addition, the software doe not
remember the bounding box a user has created in a previous session, so
when the user wants to alter any Bounding Box query, the bounding box is not
auto-populated from the previous session.

7.10 Limitation #10

Attachments

There is no capability to create attachments in WKC. You can only read
something that is authored in DPE.

7.11 Limitation #11

Attachments

If the web browser is IE6.0, and you select multiple hyperlink attachments to
open them, only the last hyperlink attachment will open because IE6 cannot
support opening in multiple tabs.

7.12 Limitation #12

Library

Non-text attributes of a Library Item, such as hyperlink, parameters, scripts,
etc., are not supported if you create an instance of work instruction from the
Library Item. The only attribute that is used is the text of the Library Item.

7.13 Limitation #13

Library

There is no automatic update of all associated work instruction text objects if
the library item from which it has been instantiated from changes. But the
software does save a link from the work instruction to the Library ltem. This
link can be queried in the DPE to find out the impacted work instruction texts if
a Library ltem is changed.
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7.14 Limitation #14

Library

The Libraries and Library Items posted for selection in W1 Composer are only
the ones that are associated with WIText Plan type. There is currently no
support for any other plan types.
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8. Best Practices/Methodologies

WI Composer will load the geometry that is already created and stored some-
where in the file system. The geometry files are to be generated using the
3DVIA Sync tool. There are different options provided in the 3DVIA Sync to
generate the files and the choice of the right option is based on the user sce-
nario.
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9. Glossary of Terms and Abbreviations

Terms Abbreviations

Bridge EH-MH Bridge

DPE Process Engineer

EH Engineering Hub

FTA Functional Tolerance and Annotation

IPD Integrated Process Database

LI Library Item

MA Manufacturing Assembly

MH Manufacturing Hub

MK Manufacturing Kit

PAR Process Attaches Resource

PCP Process Creates Product

PDR Process Detaches Resource

PFPP Process First Processes Product

PIR Process Implements Requirements

PPP Process Processes Product

PROR Process Runs on Resource

PRP Process Removes Product

PUR Process Uses Resource

SMGXML, SMGGEOM, and SMGVIEW These are the different file formats for reading /
writing the data that is understandable to 3DVIA
applications

3DVIA 3DVIA is a brand in the Dassault portfolio

3DVIA Composer Application that allows user to author mark-ups,
text, annotations, etc.

3DVIA Player Free downloadable viewer application that allows
you to view the data created using Work Instruc-
tions Composer and to make basic mark-ups, an-
notations authoring, etc.

3DVIA Sync Application that allows user to convert data from
CAD vendors to SMG format, etc.

WI Composer Work Instructions Composer
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